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Notice to users

Warranty
No undertaking is made on the part of the State in relation to the performance of results produced by the software. Without

limiting the generality of the foregoing, the State does not warrant or make any representations whatsoever regarding the

correctness, accuracy, reliability, friendliness, currency or any other aspect in relation to characteristics or use of the software.

Sole responsibility and risk associated with the use and the results of the software irrespective of the purpose to which such use

or results are applied is accepted by the user. Where the users supplies results or information arising from or out of the software

to any third person, the user agrees to indemnify the State against any claim arising from such results or information. Any other

warranty expressed or implied by statute or otherwise is, to the extent allowed by law, excluded from this agreement.

© State of Queensland, Department of Primary Industries 1995

Copyright protects this publication and its related software. Except for purposes

permitted by the copyright Act, reproduction by whatever means is prohibited without

the prior written permission of the Department of Primary Industries.

Inquiries should be addressed to:

Kurt Derbyshire
Department of Primary Industries
Northern Fisheries Centre

PO Box 5396
Cairns Qld 4870
Phone(070)529 888
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Introduction

Background

Geographical Fisheries System (GFS) was developed as part of a project jointly
funded by the Fisheries Research and Development Corporation, Queensland Fisheries

Management Authority and the Department of Primary Industries, Queensland and

based at the Northern Fisheries Centre, Cairns. The project 'Small prawn habitat and

recruitment study' (FRDC 92/7) ran from July 1992 to June 1995. GFS was
developed during the period August 1994 to June 1995 as an animated, interactive
model for displaying the data collected during this project. It can also display other
user's data, making GFS a more flexible tool.

What GFS can do for you

Geographical Fisheries System (GFS) is an interactive, animated tool for visualising

fisheries data. It is able to read M.ap Info mif files for importing maps, whilst Access,

Paradox, SQL Server, Btreive, Excel and text files can be read for data input. The data

can then be displayed on a map. GFS has the facility to track movement through time

on the map (such as in tagging data). GFS also has thematic mapping functions (such

as densities or species composition at each site mapped through time). Although GFS

is set up to be specific to this project, it has been developed to be flexible enough for

many different applications depending on the data input.
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Contents of GFS package

The Geographical Fisheries System contains :
• hard-cover holding box

• loose-leaf Users Guide in folder

• software licence agreement

• six (6) computer floppy disks (3 '/z") as follows:
four (4) 3 'A" GFS disks
two (2) 3 ',2" PrawnEd disks

GFS Users Guide 7



Installing GFS

Computer requirements

GFS will run on any IBM-compatible PC with at least :
• 386 CPU
• DX 33MHz
• VGA monitor

• 10 Mb free hard disk space
• Windows 3.1

• 8 Mb RAM

Installing GFS

Installation

1. Ensure no other applications are running.

2. Insert GFS Diskette 1 into Drive A.

3. Type "a: setup" and press enter.

During the setup you will be prompted to select from a list of ODBC drivers. You

may choose any drivers you please, but it is recommended that you choose the

Microsoft Access Driver to use with the sample database provided.

A program manager icon will be created automatically.

GFS Users Guide 8



Quick start

To help you off to a quick start GFS is provided with a Sample Project called
TurtleG. This Project contains displays of the following fisheries research data
collected in the Turtle Group region of Queensland's north-east coast in 1993 and

1994:

• Turtle Group Prawn Tagging

• Turtle Group Commercial Prawn Species Composition

• Turtle Group Commercial Prawn Size Composition

• Turtle Group Juvenile Prawn Species Composition

To open one of the Sample Analyses, choose the file TurtleG.prj from the File menu.

Next, choose the Analyses tab of the Project window. A list of available Analyses

will be displayed. Choose an Analysis and click the Open button.

Quick help

GFS contains comprehensive on-line Help. Help may be obtained by choosing the

Help Contents command from any menu. Additionally, you can use the Context Help

command to obtain detailed help on any part of GFS. When you choose the

Toolbar's Context Help button, the mouse pointer will change to an arrow and

question mark. When you click somewhere in the GFS window, such as a Toolbar

button, the Help topic will be shown for the item you clicked. When a dialog box is
active, Fl must pressed to use help.
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Geographical Fisheries System

Projects
Project window

The Project window keeps track of the files (Maps and Analyses) associated with a
particular Project. An example of a project is the sample Turtle Group Project file

which includes the Turtle Group map and various analyses. A Project can have more

than one Map or Analysis associated with it, and a Map or Analysis may be associated

with more than one Project.

Users can open an existing Project by choosing Open Project from the File menu, or

create a new Project by choosing New Project from the File menu.

From within the Project window, users can choose the GFS Maps tab to open or create

a Map, or the GFS Analyses tab to open or create an Analysis. A Project can be saved

by using the File Save command or File Save As command. Following are two

examples of Project windows. The first example shows the Analyses tab, while the

second shows the Maps tab.

Maps can be added or removed by using the Add files or Remove file from the File

menu.

GFS Users Guide 10
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Geographical Fishery System [TGP Release] -TURTLEG.PRJ

File Edit View ^Vindow Help

1934 Turtle Group Tagging
Brown Tiger Size Analysis
Tuitle Group Species Analysis

A Project window with the Analyses tab visible

GFS Users Guide 11



File Edit View Window Help

A Project window with the Maps tab visible
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GFS Maps

The major interface element of GFS is the Map window. It is used to display both the
map and any temporal and/or spatial elements created by GFS. GFS allows users to

import Map Info maps, or modify existing ones. Users can also create (draw) their

own maps with GFS, however this is not recommended. Rather, we encourage you to

experiment with existing or imported maps by adding new features if these are

required.

Geographical Fishery System [TGP Release] - [Turtle Group Map]
File Edit Draw Object View Disfilay Analysis Tools Window Help

An example of a GFS Map.
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Opening an existing Map

Existing maps can be opened from within the Project window. Maps are also opened

automatically by Analyses during visual analysis functions, such as view tag data in a

Tag Analysis.

Creating a new map

To create a new map choose the Maps tab in the Project window and press the New

button. This will create a new blank map. New features can be added using any of the

mapping tools. We recommend, however, that you only use existing or imported

maps, and add new features to these with the map tools.

Changing the View

The way the map is viewed in GFS is left for you, the user, to decide. You may

change the scale of the map, or even the background colour. You may change your

view location and modify various map object styles such as colour , line type or even

fill patterns. One of the things you may wish to change is the Map Settings.

IVIap Settings

The Map Setting dialog can be found under the File menu. The following dialog will

appear.

Map Attributes

^s^ |90.
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Map Settings Options

Background Colour - This is used to select the background colour. Most users

generally prefer either white or blue (to represent the ocean).

Interest Area - The interest area in GFS is the area that can be moved to by using the

scroll bars. It is also used in the Zoom Out - Fit to Window option. GFS allows maps

to be any size you require, however you may only want to concentrate on a small area.

This can be achieved by setting the bounds for the area. This does not delete any

objects that aren't in the interest area, it just prohibits the user from scrolling into non-

interest areas. You may change the interest bounds any time.

Gridlines (View menu)

Grid Lines enhance the ability for you, the user, to be able to determine your location

on a map. This is particularly useful for people familiar with navigation charts. There

is, however, some variation between GFS maps and navigation charts because GFS

projects the map in a latitude/longitude projection system which doesn't take into

account the earth's curvature. This should only pose a problem if your interest area is

either very south or north. Future versions of GFS will allow different map

projections to help overcome these problems.

The Gridlines command shows map gridlines with the following options:

Large - A gridline at every degree

Small - A gridline at every six minutes.

You may turn the gridlines on or off by choosing the command from the Menu.
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Changing the scale and position of Maps

The scale and position of the map can be changed by using any of the following
commands in the Display menu.

Zoom In

IC&

MB

s.

Zoom In I

This command allows you to Zoom in on a map. The dialog box offers a range of

zoom ratios, including a custom entry. The zoom ratio of the current map will change

according the choice (or custom entry) made. The center of the map will remain

constant during the Zoom.
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Zoom Out

Zoom Out

Bfl

This command allows you to Zoom out and displays the Zoom Out dialog box. This

dialog box offers a range of zoom ratios, including a custom entry. The zoom ratio of

the current map will change according the choice (or custom entry) made.

Additionally, 'Fit To Window' restricts the user to the bounds of the map interest area.

The interest area can be modified in the Map Settings dialog. As with the Zoom In
function, the center of the map remains constant.

ZOOM OUT

This command will zoom the user out to the previous zoom that is further away than

the current Zoom. If there are no previous zooms then you must either use the Map

Settings dialog or the Zoom Out command.
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Zoom Tool

The zoom tool allows you to interactivly zoom in on a map area by creating a

rectangle on the map indicating the area you wish to zoom in on.

Refresh Screen

Choose this command to repaint the screen. Use when the screen image appears

disjointed, unclear, messy, etc.

Map View Settings (Display menu)

The map view settings dialog contains several options for setting the view.

Map Scale

Use to set the ratio of screen view (cm) to real world (km). This will change Zoom
(Window width) automatically

GFS Users Guide 18
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Centre Of Window

Displays the geographical position of the centre of the Map window.

Zoom (window width)

Use to set the width (in km) of the zoom window. This will change Map Scale
automatically

Importing Maps (Advanced users only)

GFS is able to import maps created in Map Info 3. To import a map load the map in
Map Info and save it as a MIF file with a Latitude/Longitude projection, you should
then be able to import the map. GFS maps are limited to approx 15000 map objects,
with polygons limited 15000 points. The maximum size ofaGFS map is also limited
by available memory. Should you be unable to import a map, try increasing the

windows swap file size as GFS takes advantage of Windows Virtual Memory. Future

versions will overcome these limitations.
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Map Tools (Advanced users only)

GFS allows users to draw their own maps and objects on maps. The Draw menu

contains the following commands.

Select

Line

Rectangle

Round Rectangle

Ellipse

Polygon

Polyline

I Text

Use for selecting objects

Use for creating line objects

Used for creating rectangular objects

Used for creating round rectangular objects.

Used for creating elliptical objects

Used for creating polygon objects

Used for creating polyline objects

Used for creating text labels

All of the above commands are also available on both the Draw menu and as buttons

on the Toolbar. Use Select to select an existing object. Use the remaining commands

to select the type of drawing tool for creating new map objects.

Select Tool

Use this command to select an object and manipulate existing objects. Existing

objects can be manipulated by grabbing (holding the left mouse button down) object
handles and moving them to new locations.
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Changing the placement of Objects

The placement of objects can be changed. When objects are created each new object is

placed in front of all previous objects. If you wish to change the location of an object
you can do this by using the Object Menu Commands.

The Object menu contains the following commands:

Object properties Set object properties.
Move To Front Move object to front.

Move To Back Move object to back.

Move Forward Move object one step closer to front.

Move Back Move object one step closer to back.

Object properties

Object properties command allows you to change the properties of the selected object.

This dialog can be started by choosing Object Properties from the menu or by double
clicking on an object.
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Use this command to set/change the properties of an object. The options are self

explanatory.

Information Tool

The Information Tool becomes active when the cursor is positioned over GFS Maps

while GFS Analyses are in progress.

By double-clicking an object on the map, the user is provided with details about that

object (eg a tagged prawn, closure lines or thematic data from a sampling site).
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GFS Analyses

GFS Analyses are designed to spatially (geographically) display data.

Starting GFS Analyses

To start a GFS analysis, select the Analyses tab in the Project window. Either open an

existing analysis by clicking the Open button or create a new analysis by clicking the
New button.

If you choose a new analysis, the New Analysis dialog will open. There are two types

of analyses available in GFS:

• Tag analysis - Use to analyse movement data.

• Thematic Analysis - Use to analyse data other than movement data.

New Analysis

3E
UlF;]

Thematic Analysis

As GFS Analyses are spatially (geographically) based, they must be associated with
appropriate GFS Maps. If necessary, GFS prompts the user to choose a map at the

appropriate stage during analyses. The user can change the currently selected map by

using the Choose Map command in the File menu.
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Tag analysis

Tag Analyses are used to spatially (geographically) view movement data through time.
This is a visual analysis and data is displayed in an animated form. This analysis was
designed primarily for tag return data, however it can also be used for other movement

data provided the data is in an acceptable format.

Starting a Tag Analysis

Users can open an existing analysis or create a new analysis, by either choosing New

or Open respectively in the Projects window. Below is an example of an existing tag

analysis. If you create a new tag analysis, the form will be empty until the Add

Record command in chosen.

145.14516666 • -14.7586GG6G

11
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Creating Tag Records

Tag records can be created in two main ways, either using the fonn-based input

screen, or by using the Import Data Wizard.

Form based Data Entry

Data can be added by choosing the Add New button or choosing Add New from the
record menu. A blank record will then be available for entering the tag data. The data

consists of the following.

Minimal Data Required :
• Release date (dd/mm/yyyy)
• Release position (decimal latitude & longitude)
• Return date (dd/mm/yyyy)
• Return position (decimal latitude & longitude)
• Route (draw a movement path for each tagged animal)

Optional Data:
• Tag_ID - Enter an identifier for each tagged animal.

• Sex - Enter the gender of each tagged animal.

• Species - Enter a species name for each tagged animal.

• Size At Release - Enter the size at release for each tagged animal.

• Return Size - Enter a size at recapture for each tagged animal.

Once you have entered the details of the Tag you may choose a route for the tag to

follow. A route is a path which the tagged prawn will follow &om the release to the

return position. This enables you to plot a path that avoids obstacles such as islands or

coastline.
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Drawing the route

An icon (the default icon is a red prawn) will appear on the map at the release and

return positions for the current record. Place the mouse over the release icon and,

holding the left mouse button down, draw a line to the return icon. The line can take

any path between the release and return positions. Release the left mouse button when

the mouse is positioned over the return icon. This must be done for every tag record

including records imported using the Tag Import Wizard if you wish to use the Run
command. The View All command, however, will show straight line paths.

Record Command Buttons

Previous record - Returns to the previous record in the database.

Next Record - Moves to the next record in the tag database.

Add Record - Adds a record to the tag database.

Delete Record - Deletes a record from the tag database.

Update Record - Choose to update an existing record in the tag database.

Import Data - Choose Import Data to import data into a tag analysis.

Run - Choose Run to show an animated output of tag data on the appropriate map.

View All - Choose View All to show all tag release and return positions with

movement direction vectors on the appropriate map.

Displaying Tag Data

Tag data may be displayed in two ways. Use the View All command to display all the
prawns at once, or the Run command to show the prawns moving through time.
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Using the View All Command

The view all command will show all the tagged prawns at once, with a vector

spanning from its release position to its return position. Vectors may pass through land

depending on the release and return positions.

Using the Run Command

To view the tag analysis temporally, click the Run button. The Time control will
appear on the Map. Use this to start the animated display of movement data by

clicking the Play button.

Each data point (eg a tagged animal) will move from its geographical release position
to its geographical recapture position at a rate determined by its release and recapture

dates. Each data point in GFS is represented by a red prawn icon. The path that each

icon takes is determined by the route that was drawn using the Route command - if no

route was chosen the tagged animal will not be displayed.

When each icon reaches its recapture position, it disappears. At any stage in the

analysis, the user can double click an icon for an update on the movement information

for that particular moving data point. This action will display the Tag Data dialog
(See Below) for that icon. You can view all the available data for an tagged animal

by clicking the View Complete Data button in the Tag Data dialog. This action will
display the Complete Tag Data dialog.
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145.160362 77013993

Tag Data Dialog - Obtained by double clicking a tagged Prawn
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Importing Tag Data

Tag Data can be imported into a Tag Analysis by using the Tag Import Wizard.
However you still must use the Route command to add a tag route.

Tag Import Wizard

The Tag Import wizard assists the user with importing data from an external source

into a GFS tag analysis. This wizard is activated when the Import Data button in Tag
Analysis dialog options is clicked.

A series of four dialogs appear. Pick an option and then proceed to the next dialog by

clicking the Next button. If you make a mistake, click the Back button to go back one

step (or else Cancel). The procedure for using the wizard is as follows:

Importing Tag Data - Step 1

GFS Users Guide 29
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Choose an existing tag document file to import, or enter a custom SQL statement. If

you choose to import an existing tag document file, the Choose File button will
become active. If you choose to enter an SQL statement, the Data Source button will

become active. Clicking the Data Source button activates the Enter Query dialog box.

This dialog offers the choice of entering an SQL statement, or clicking the MS Query
button. Users who have MS Office may use MS Query to create the SQL statement

and ODBC connection. You can configure custom data sources for GFS by using the

ODBC Administrator in Windows Control Panel. These data sources can include MS

Access, Paradox, Excel, Btrieve and text files, depending upon the drivers installed on

your computer system.

Importing Tag Data - Step 2

Select fields for the Release Details dialog. Date must be a true date field (not a

string). Latitude and Longitude must be in decimal notation.

Importing Tag Data - Step 3

Select fields for the Return Details dialog. Date must be a tme date field (not a
string). Latitude and Longitude must be decimal. The dialog is very similar to the
dialog above in step 2.
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Importing Tag Data - Step 4

Select fields for the Optional Data dialog. This data is not mandatory for a tag
analysis. TagID, Sex and Species are alphanumeric fields. Size At Release and

Return Size must be decimal numbers.

Click the Finish button to end the data import procedure. Now that you have imported

the data you must add the tag routes. See the prior section about adding routes.
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Thematic Analysis

Thematic Analysis command (Analyses window)

Use this command for a spatial (geographical) analysis of data other than movement
data. This analysis was designed primarily for monthly sampling data collected from
a prawn fishery, but can be used for any data of a suitable format. The Thematic

Analysis dialog outlines the data required for a Thematic Analysis.

Starting a Thematic Analysis

Users can open an existing analysis or create a new analysis.

Opening an existing Analysis

Choose the Analyses tab in the Project window. Existing Analyses will be displayed.

Double click on an existing Analysis to open it.

Creating a new Analysis

To create a new Thematic Analysis, choose the Thematic Analysis option in the New

Analysis dialog. This will open the Thematic Analysis dialog which enables you to
choose data options. You will also be prompted to choose one of the available GFS

Maps. The time steps of the Analysis can be set using the Set Persistence command

which will be discussed later in this section.

GFS Users Guide 32



33

Data display

When a Thematic Analysis is opened, the Thematic Analysis dialog will appear.
Click the Show Data button to proceed with the Analysis.

Thematic data objects in the form of coloured circles will appear on an associated

map. The colour of the circle indicates the dominant data group (eg species) at each

sampling site. Colour codes for data groups appear in a Legend. GFS supports 16

colours. If you have more than 16 data groups, GFS will "wrap around" and reuse

colours already in use. The size of the circle indicates the relative magnitude of the

thematic object (eg prawn density at that site). An 'X' on the map signifies that a site
was not sampled.

The Information Tool can be used to display details (eg prawn species composition at

a sampling site) about a thematic object on the map. Users can choose to have this

information displayed in either bar or pie chart format. Double click a closure line to

display a comparison of data groups from inside and outside the closure. Click the

Closure Graph button on the Thematic Analysis display to display a summarised
comparison of all current closures.

The Time control will also appear on the map. This is used to run the analysis through

time and can be moved and re-sized. Users can Zoom to any area of the map using the

Zoom Tool. Closure lines can be added to analyse the data.
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Thematic Analysis dialog

This dialog box appears when a Thematic Analysis is opened or created. It contains

the following options for Thematic database manipulation and display:

Data Source

Click the Data Source button to choose a database to import. This action opens the

Data Import Wizard. GFS can import data from any ODBC source for which the user

has a drivers. Examples of compatible data files include Access, Paradox, Excel and

text files.

Refresh Data

Click the Refresh Data button if you have updated your data source and do not wish to

reimport. This action will update the data in GFS. You will, however, have to reset

the Persistence (the time groups of your data).
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Show Data

Shows the thematic Objects on the map, the time control is also started.

Closure Graph
Click this button to display a summarised comparison of all closures defined in the
current Thematic Analysis.

Show Closure

Click this button to display closures which have been added to a Map.
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Set Persistence

Set Persistence command (Thematic analysis dialog options)

Use Set Persistence to define the time groups of your data. This command is

especially useful if data was collected in a "lumped" fashion (eg sampling took place

over several days each month) or irregularly (eg sampling took place at irregular

intervals through the course of a year). If the time groups are chosen appropriately,

temporal data will be displayed on GFS Maps with appropriate time steps.

GFS Users Guide 36



37
Upon choosing this command, the Time Group dialog will appear with a list of dates.
Dates that are black or red contain a data sample. Click the first date that you wish to

include in a data group and drag the mouse to the last date that you wish to include in

the group. Click the Group button. Selected dates that contain data will now appear

red and a group number will appear next to the grouped dates in the date list. The

range of grouped dates will also appear in the dialog. Repeat this procedure for each

temporal group that you wish to create. Use the Ungroup button to undo a group. If

you select dates that are already grouped they will reset to the new group (ie they
don't need to be ungrouped).

Change Labels

IH£2

|Specie

|No

:hange Labels

_1

i•

This command allows you to change the labels used for displaying graphs.
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Show Legend

The Legend appears when a Thematic Analysis is opened. Thematic data groups

which appear in an analysis are defined in the Legend. GFS supports 16 colours. If

you have more than 16 data groups, GFS will "wrap around" and reuse colours already

in use. The Legend can be moved by selecting the Title Bar and dragging to a new

position, and re-sized by dragging the handles.

Add closure

Click this button on the Thematic Analysis dialog to draw a closure on a Map. Please

read the section on the information tool.

The Map will be displayed and the cursor will appear as the Closure Line Tool when it
is positioned on the map. The closure must be drawn as a polygon, not just a line

from one point to another. In other words, you need to draw the inner bounds of the

closure (eg trace along the coastline) as well as the outer bounds. Click the left mouse

button to begin drawing the closure. As you move the cursor, it will appear as a cross,

and a polygon (the closure) will form. Clicking the mouse as you move it adds nodes

to the closure. You can later modify any closure by clicking and dragging nodes.

Double click or press Escape to stop drawing the closure. Then move the cursor off

the closure line and the cursor will change to the Information Tool. Double clicking

the Information Tool on the closure line will display a graphical comparison of data

from the closed area(s) and the open area.

You may also import a closure from an existing Analysis using the Import Closures

menu command.
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Modifying a closure

Select the Closure Line Tool from the Toolbar or the Analysis Tools Menu
Commands. Click once on the closure line. This makes the nodes on the closure line

visible. Click and drag a node to modify the closure line. You can add nodes by
holding down the Control key and clicking on the closure line. Holding down the
Control key and clicking on an existing node will delete that node. To move the entire

closure Polygon, click on the closure line (not on a node) and drag to a new position.

To remove a closure, click on the closure line once with the Closure Line Tool, then

press the Delete key. If you wish to add a different closure, you must return to the

Thematic Analysis dialog and click the Add Closure button again. Pressing the Shift
key and clicking on the closure line creates a copy of the current closure.

The style of the closure can be changed by double clicking on the closure line with the
closure tool, this will start the closure attribute dialog box.
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Import Closures

Use the file import menu command to import a closure from an existing Thematic

Analysis. This is useful if you wish to have the same closure in different Analyses. A

file open dialog will appear allowing you to import closures from any thematic view
(*.thm files).

Data Import Wizard

The Data Import Wizard is activated when users click the Data Source button in the

Thematic Analysis dialog. A series of three dialogs appear. Pick an option and then

proceed to the next dialog by clicking the Next button. If you make a mistake, click

the Back button to go back one step (or else Cancel). The procedure for using the

Wizard is as follows:

Step 1

Choose a data source. Clicking the 'Data Source' button activates the 'Enter Query'

dialog box. This dialog offers the choice of entering an SQL statement, or clicking the

'MS Query' button. Users who have MS Office may use MS Query to create the SQL

statement and ODBC connection. You can configure custom data sources for GFS by

using the ODBC Administrator in Windows Control Panel.
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Step 2
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Exit from your successful Query. This will rehim you to the Data Import Wizard.

Click the Next button. This opens a dialog in which the user enters the following
sample details:

Date - Date sample taken. Must be tme date field data.

Latitude - Must be a field containing decimal latihides. Latitudes south of the equator

must be negative.

Longitude - Must be a field containing decimal longitudes. Longitudes West of zero

must be negative.

Area - The area of the sample (eg a trawl sample might cover an area of 4 ha). If no

area is entered, raw numbers (rather than densities) of each class field will be plotted.

ID - Optional identifier for location of sampling site (eg site 1).
Class field - Choose the way in which the data is grouped (species, size classes, etc).

Number - The number in each class field (data group).
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Step 3

Click the Next button. This opens a dialog in which users enter:

Area - Enter the unit that the sample area is measured in.

Class field - Enter the name of the class field (data group).

Number - Enter the number type (count, weight, etc).

Click the Next button. This will return you to the Thematic Analysis dialog to
proceed with the Analysis.

Missing data

Missing data can be incorporated into the Analysis by entering zeros in the Area and

Number fields of your database. For example, if site 'A' was not sampled at a

particular date, make sure a zero is entered in the area and number fields of your

database for that date. An entry will also be required in the latitude, Longitude and

Class fields. Such a record in your database will produce an 'X' on the Map during the

Analysis, which signifies missing data.
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Import errors

Inconsistencies and detected errors in imported data are reported in the Import Errors

dialog box. The error explanations are available at run time.
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Time control

The Time Control dialog appears when temporal objects (eg tagged prawn or monthly
sampling data) are present on GFS Maps. Use the Time Control to browse through

data temporally. The control has the following options:

Rev Runs GFS Analyses back through time fast.

Stop Stops analyses. This can be especially useful if you want to use the

Information Tool to display details about several thematic data objects on the Map.

Play Runs analyses.

FF Runs analyses forwards through time fast.

fast (») Speeds up the rate at which the analysis proceeds.

slow («) Slows down the rate at which the analysis proceeds.

Date The date is displayed as dd/month/yyyy. Users can change the date by
'clicking on it and the Set Time dialog will appear. Type in the date (dd/mm/yyyy)
you wish to view and click OK. The display will update immediately to the new date.
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Special Analysis Functions

Choose Map

This command allows the user to change the currently selected GFS Maps.

Rename title

Use to rename the title of a an analysis, can also be used to rename map windows. To

change the title the analysis or map must be open.
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Prawn Ed

Introduction

PrawnEd was developed as an educational tool to help people at all levels become

more familiar with the biology of prawns caught during the Turtle Group project. It
also provides some analysis of the meteorological data of the area during the period of

the study. It was intended to aid decision makers, but may also be useful to others

such as students and fishers.

Installation
1. Insert PrawnEd Diskette 1 into Drive A.

2. Type "a: setup" and press enter.

Note : PrawnEd must be run in screen modes that support small fonts.

Using PrawnEd

Getting Started

1. Double click your mouse on the PrawnEd icon. / You will arrive at the

PrawnEd Menu Gallery. This is in the form of a room that has pictures hanging on

the wall, a window, door, 'flying prawns' and a book on the floor.

2. Move your mouse cursor around the room and you will see the names of the

various functions available pop-up. These functions are accessed by a single left

mouse click when the title appears.
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General Information

1. Click on the picmre of the prawn to access the General Information section. This

section gives you information on different aspects of each prawn species found in

the Turtle Group region.

2. Move your mouse cursor over each heading to reveal the information on the prawn

species named in the plaque at the top of the picture.

3. Change to the next species using the arrows at either side of the species name.

Click once on the arrowr;and the next species name and picture will appear.

4. To exit the General Information section and return to the PrawnEd Menu Gallery
'"JPdiGkJtfri6biwithifcMeft mouse button on th^-'exit button.

Life Cycle

1. Click on the picture of the prawn life cycle to access this information section. This

section gives you an account of each life history stage of each species found in the

Turtle Group region.

2. Move your mouse cursor over the pichire of the life history stage to reveal

information on the prawn species named in the plaques at the top (common) and

bottom (scientific) of the picture.
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3. To change to the next species click the arrows at either side of the species name and

the next name will appear.

4. To exit the Life Cycle section and return to the PrawnEd Menu Gallery click once
with your left mouse button on the exit button, s.^,.. ^

.<" grit ao

Distribution . ^ is no

•jiruj'; ...

./^•/oM ,:

i-or'i'M

1. Click on the picture of the map of Australia to access this information section. This

section gives you an account of the Australian distributioui of each species found in

the Turtle Group region.

2. The map pictured shows the disfribi^t^ of ^e^raw]a(Spq(^e^^9d^tNd?|aque
at the top of the picture.

3. To change to the next species click the arrows at either side of the species name and

the next name will appear.

4. To exit the Distribution section and return to the PrawnEd Menu Gallery click once

with your left mouse button on the exit button.
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IVIeteorological Data

1. Click on the window to access this information section. This section gives you

three graphs that describe meteorological characteristics of the Turtle Group region.

2. lit the£ Meteorological Data Menu, move your mouse cursor over the graph name
~ '^)iyques tfo reveal information on each graph.

3. To view the graph, click your left mouse button on the name plaque of your choice.

To view anotKB? graph'return to the Meteorological Data menu by clicking the exit

button.

4x1^1^2!f^s^ctf6fliStfi-1-emn^Ktd;%e Pr^WiEdi!Meffl Gallery click once with the
ny%ftelte<bteAJ6ntfi^it buttonl()f000^

Prawn Size
I • ';if3^ "••

1. Click on the 'Flying Prawns' to access this information section. This section

displays graphs of the frequency of size classes of prawn species found in the

Turtle Group region.

2. The graph pictured shows the size frequency of the prawn species named in the

plaque at the top of the picture.
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3. To change to the next species click the arrows at either side of the species name and

the next species name/graph will appear. ;.

4. To exit this section and return to the PrawnEd Menu Gallery click once with the

left mouse button on the exit button. .. -. -

Catch & effort
»^ ^'f ^ :^_2_,i^^ /

•>';v °fh no ;'3: /

riqm§ 3?i{i.r

1. Click on the book on the floor to access this information section. Tj^s^^e^ofr
gives you three graphs that describe catch and effort information &oig^the ^gtle
Group region. This is summarised from logbook records.

'V /"•:i" .,..,>-'.„ •

2. In the Logbook Catch and Effort Menu, move your.. piou^e;,curs^ over the graph

name plaques to reveal information on each graph.

3. To view the graph, click yo% left iwnse^uj^pi^pigfig ^qv^^p^^ce^
To view another graph return to the MeteoroljOgic^j ^^$a menu, b^c],K^i^^ths, exit
button.

4. To exit this section and return to the PrawnEd Menu Gallery click, once with the

left mouse button on the exit button. . -

Exiting PrawnEd
•i. • 'r !

1. Click on the door to open it. 'You will be asked "Are you sure you want to exit

PrawnEd?" Click on the 'yes' button to exit or 'no' button to remain in the

PrawnEd Menu Gallery.
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Glossary

MS Query
MSQuery is a visually interactive query tool for developing SQL statements. MS
Query is not part ofGFS. It is developed by Microsoft and comes with the MS Office
suite of software. See MS Office user manuals or MS Query help for further

information.

Maplnfo
Maplnfo is a Geographical Information System.

ODBC
Open Database Connectivity is used for connecting to various Database sources.

SQL
Structured Query Language is a language used for extracting data from a database.
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GFS is a dynamic tool for fishery managers, fishers, scientists and students.

This package will allow you to:
•visualise data on a map through time

•see data from a prawn fishery research project displayed
•manipulate closure lines and view the results
•importMacp]nfo maps

•read data from Access, Paradox, Excel, text files and more

GFS features include:

•detailed on-line help

•fall colour graphics

•easy to use Windows application

PrawnEd educational module included

hi
Minimum system requirements:

•8mb RAM
•10mb of free hard disk space
•386DX33
•Windows 3.1




